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The Blackbird Power BI Custom Connector, enables users to liberally query, analyze and visualize 
data from the Blackbird system. This can be useful for making custom reports, or connecting 
Blackbird with other data sources, available in the organization. 

This guide will take you through preparing Power BI Desktop for the connector, and how to use it. It 
is assumed that Power BI Desktop is already installed. If this is not the case, please either download 
it1 or contact your local IT administrator for help on this. 

Please have the following ready: 

• A computer with Power BI Desktop installed 
• A Blackbird API token 

If you are missing either of these, please contact your local administrator for help on how to set 
these up. 
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Preparing Power BI Desktop 
We first need to enable loading Custom Data Connectors, by going into File -> Options and Settings -
> Options. 

 

Once the Options dialog has opened, switch to the Security tab, and in the Data Extensions section, 
choose Allow any extension to load without validation or warning. 
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Press OK and close Power BI Desktop. 

Copy the Blackbird Data Connector (the .mez file) into the folder [My Documents]\Power BI 
Desktop\Custom Connectors. This will make it available to Power BI Desktop. If this is the first time 
you add a custom data connector, you might need to create both the Power BI Desktop folder and 
the subsequent Custom Connectors folder. 
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Using the Custom Connector 
You are now ready to open Power BI Desktop again. Once the application is ready, choose Get Data 
and then More…. 

 

Choose All and then search for Blackbird. You should now be able to select the Blackbird Connector 
(beta) from the list of connectors. 
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You might get a warning dialog, stating the connector is still under development. Check off Don’t 
warn me again for this connector and press Continue. 

 

First step is to choose the correct Cloud to connect to. If you are located on 
https://cloud.blackbird.online, then simply enter either “cloud” or “shared” and press OK.  

NOTE: If you are on a private cloud, you’ll need to enter the name of your private cloud. This can be 
found in the URL you use to access Blackbird, and will be the part between cloud and blackbird, e.g. 
the YOURCLOUD part in https://cloud.YOURCLOUD.blackbird.online. 

    

You will now be asked to enter your Authorization credentials. Enter your API token. If you do not 
have any API tokens yet, please contact your local administrator for help on this. 
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Selecting Your Data 
You should now be presented with the navigation view, which will allow you to select the data you 
are interested in. 

 

You should now see a list of years, starting from 2019, and going until the current year you are in. 
Expand the year, by clicking on the arrow icon. You should now see a list of months of the year, 
quarters, and finally a combination of quarters for a 6 month view. 
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We can either choose to view data directly from one of the quarters, Q1-4, or quarter combinations. 
Or, we can drill down further, by expanding a month that we are interested in. When you expand a 
month, again by clicking the arrow icon, you should see a list of days in the month, and additionally 
an entry called “00 Full Month”. 
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The full month entry will let you see data for the period of the month (i.e. first day of the month to 
the last day of the month). If you expand a day, by clicking on the arrow icon, you are now presented 
with two options, in the form a “Devices” entry, and a “Lines” entry. 

 

This is where you need to know what data you are interested in. If you want to view data from a 
specific peripheral (i.e. PLC tag, sensor, etc), navigate into Devices. If you want to view data for a 
whole line, navigate into Lines.  

Let’s first explore what data is in a Device, by expanding the Devices entry. 
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You will now be presented with a list of all the devices that you have access to. We can now expand 
a specific sensor/PLC tag/etc that we are interested in. 

NOTE: This access is based on what permissions your API token has. If you cannot find your own 
device here, contact your local administrator, to make sure that the API token you have received, also 
has access to the devices you are interested in. 

 

Once expanded, you now have the option of choosing between different data options. A brief 
explanation is as follows:  

• Information – Basic information about the device, and the time range you are looking at 
• Samples – A list of samples in the time range that you are looking at 
• Stops – A list of stops in the time range that you are looking at 
• KPIs – The KPIs, calculated from the time range you are looking at 
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• OEE – The OEE statistics, calculated from the time range you are looking gat 
• Batches – The batches that have run in the time range you are looking at 
• Raw – All of the data, in a raw format, if you want to manually create your own data tables 

Once you have figured out what data you are interested in, check off the ones you want, and click on 
the Load button. 

 

You will now see a loading screen, while Power BI fetches the data from the Blackbird API. 

 

After the data has been fetched, you can see your data fields, in the right side of the Power BI app, in 
the FIELDS column. 
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With these fields, you can create your own reports, and even combine the Blackbird data, with data 
from other systems.  

If you have chosen the same data as in the screenshots (Information, Samples and Stops), you are 
ready to proceed to the two next sections, on creating a Data Graph and Stops Pareto from the data. 

Alternative Method for Selecting Data (e.g. in Excel) 
While the navigator might be great for exploring your lines and devices, sometimes you just want to 
get ahold of some specific data. Unfortunately, Excel does not support Custom Connectors, so we 
will have to inline the functionality that the Connector exposes. 

This does require a bit of familiarity with Power BI and the M Language, but that quickly pays of. We 
will just give two examples of common cases.  

First, open Excel and navigate to the Data tab. 

 

Now, open the Get Data menu, and find the Blank Query option. 
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With the Power Query Editor window open, choose Advanced Query Editor, to get access to the raw 
M query. 
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This will open up the Advanced Editor for you. In here we will throw the query we need to extract 
data, from either Query 1 or Query 2 below. Once you’ve done that, make sure to adjust it to your 
needs, by updating the highlighted fields in the image below (will vary a bit between Query 1 and 
Query 2). 

 

After this, it’s just a matter of navigating via the interface to the data you want to access. 
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Once you have navigate to the data, click Close & Load to finalize the data import. 

 

You can now work with your data like you are used to from Excel! 

Query 1: A list of Devices and Lines 
The code is included in a file. 

1. Open the attached file Blackbird Raw Excel.query.pq 
2. Update the parameters 

a. apiKey should be your API token 
b. cloud should point to your cloud (either “shared” or your private cloud) 

3. Make sure the 3rd last line says rawData = QueryList(apiKey, cloud) 

From this list, you can get easy access to your line ids and device uuid and index. 

Query 2: Device Data 
The code is included in a file. 

1. Open the attached file Blackbird Raw Excel.query.pq 
2. Update the parameters 

a. apiKey should be your API token 
b. cloud should point to your cloud (either “shared” or your private cloud) 
c. uuid to the the UUID of your device 
d. index to the the index of your device 
e. starTime to the start of when you want data from 
f. endTime to the end of when you want data to 
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3. Make sure the 3rd last line says rawData = QueryDevice(apiKey, uuid, index, startTime, 
endTime, cloud) 
 

One thing to note in the second query is the use of MkIsoStartTime and MkIsoEndTime, which are 
used to construct the time formats we need for the query to work. It takes a year, month, date and 
then an optional hour and minute, as its arguments.  

If you give it no hour, start will default to 00 and end will default to 23. If you give it no minute, start 
will default to 00 and end will default to 59. 

Query 3: Line OEE 
The code is included in a file. 

1. Open the attached file Blackbird Raw Excel.query.pq 
2. Update the parameters 

a. apiKey should be your API token 
b. cloud should point to your cloud (either “shared” or your private cloud) 
c. lineId to the the id of your line 
d. starTime to the start of when you want data from 
e. endTime to the end of when you want data to 

3. Make sure the 3rd last line says rawData = QueryLine(apiKey, lineId, startTime, endTime, 
cloud) 

Query 4: Device Batches 
The code is included in a file. 

1. Open the attached file Blackbird Raw Excel.query.pq 
2. Update the parameters 

a. apiKey should be your API token 
b. cloud should point to your cloud (either “shared” or your private cloud) 
c. uuid to the the UUID of your device 
d. index to the the index of your device 
e. starTime to the start of when you want data from 
f. endTime to the end of when you want data to 

3. Make sure the 3rd last line says rawData = QueryBatches(apiKey, uuid, index, startTime, 
endTime, cloud) 

Connecting your Excel Power Query with Parameters 
Often you want to be able to extract parts of your query out into your Excel spreadsheet, to make it 
easy to change. For example, we could extract the start and end times, so that when these are 
updated, your query will pull data from these times as well. 

To do this, open up Excel and create a table that will hold the parameters you are interested in. For 
this example, we will create the parameters that we use in the previously listed queries: 

• startTime 
• endTime 
• lineId 
• uuid 
• index 
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Once we have done that, we will have something like the following: 

 

Now, select your table, go to the Data tab and click on From Table/Range: 

 

This will ask you if your table has headers. Make sure it’s checked off, and click OK: 
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This will drop you into the a Power Query window, which will show your table. We change the name, 
located on the right, to Parameters, so we can easily refer to it later on. 

 

After this, press Close & Load in the upper left corner. This will create a new sheet, which we will 
delete. 
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You should now only have your Parameters sheet left. Right click the Parameters connection, on the 
right side, and choose Edit. 

 

In the Power Query window, right click on you Parameters query, and choose Duplicate: 
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We’ll repeat this for every parameter we want to extract, and name each of them after the 
parameter. You should end up with five different items in the query list (not counting the original 
Parameters table). 

 

We will now convert each of these tables to a specific value, from the Parameters table. In each of 
the tables, right click and choose Drill Down on the value in the Converted Value column that 
corresponds to the parameter you want. E.g. in StartTime I will right click on the 2019-10-01… value 
and choose Drill Down: 
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Each parameter that was previously a table, will now be a single value for each of them. 

 

We are finally ready to use our parameters in our query! Open up a new blank query, by right 
clicking anywhere in the queries list, and navigating to Blank Query. 
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We open up the Advanced Editor in the top, and input our query: 

 

We can now replace our variables in our query, with the names of the parameters on the left side: 
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Click on Done and you will probably meet an error stating something like Formula.Firewal: Query….. 
Before we are done, we need to Close & Load all our queries. Press OK when Excel comes with a 
warning. 

The final step is to update a Excel setting for the specific worksheet. We want to let it allow us to 
read data from our own Excel sheet, so we need to disable a privacy setting.Open Get Data and 
choose Query Options: 
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Go to the Privacy tab, and choose Always ignore Privacy Level settings. Click OK: 

 

Finally, press the refresh button on your Query, and it will load the data using your parameters! 

 

You will also need to press this button if you change the parameters, and you want the query to 
update. 
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Creating a Data Graph from the Samples Data 
NOTE: If you already have the data available, you can skip down to the Creating the Data Graph 
section. 

Before we can work with the data, we need to make it available to ourselves. Launch the Blackbird 
Connector, from the Get Data button. 

 

Enter your cloud name (“shared” or your private cloud name), and press OK.  

After this, navigate to the device/sensor/PLC tag that you want to work with, and load the Samples 
data, by checking off Samples and clicking the Load button. 

 

After the data has loaded, you should now see Samples in the right-side of Power BI. Expand the 
Samples entry, if it’s not already expanded. 
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We are now ready to create our Data Graph. 

Creating the Data Graph 
With the sample data loaded, we are now ready to start working with it. Power BI gives us a bunch 
of tools to visualize our data, but for our purpose right now, we will only use the Line chart. Click on 
the Line chart button, in the VISUALIZATIONS toolbar. This should add an empty block in the Power 
BI sheet, that we can now manipulate. 

            

From the expanded Samples in the right-side, drag the to field from the field and drop it onto the 
Line chart block, in the Power BI page. Do the same with the from and accValue (accumulated value) 
fields. You line block should now look like the screenshot below. 

                       

This is not quite what we want. The data looks like this, because Power BI has, by default, expanded 
our to and from fields, into date hierarchies. We can fix this by pressing the dropdown button in the 
to and from properties, on the right-side, and choosing to and from respectively, instead of Date 
Hierarchy. 

      

Our Line Chart should now look a bit more like what we intended. 
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The last step is just a simple one, we can change the size of the chart, by dragging the handles in the 
corner of the graph. Drag the handles until you are satisfied with the size of the graph. 

 

 

Congratulations! You have now managed to visualize the data samples our PLC tag/sensor/etc. Play 
around with the other types of visualizations, using this data, to get a feel of what Power BI can do. 

Creating a Stops Pareto from the Stops Data 
NOTE: If you already have the data available, you can skip down to the Creating the Stops Pareto 
section. 

Before we can work with the data, we need to make it available to ourselves. Launch the Blackbird 
Connector, from the Get Data button. 
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Navigate to the PLC tag/sensor/etc that you want to work with, and load the Stops data, by checking 
off Stops and clicking the Load button. 

 

After the data has loaded, you should now see Stops in the right-side of Power BI. Expand the Stops 
entry, if it’s not already expanded. 

 

We are now ready to create our Stops Pareto. 

Creating the Stops Pareto 
With the stops data loaded, we are now ready to start working with it. Power BI gives us a bunch of 
tools to visualize our data, but for our purpose right now, we will only use the Stacked column chart. 
Click on the Stacked column chart button, in the VISUALIZATIONS toolbar. This should add an empty 
block in the Power BI sheet, that we can now manipulate. 
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From the expanded Stops in the right-side, drag the stopCause.stopType field from the field and drop 
it onto the Stacked column chart block, in the Power BI page. Do the same with the duration and 
stopCause.name fields. You stacked column block should now look like the screenshot below. 

  

Expand the Stacked column chart, by dragging the handles in the corners, until it fits a comfortable 
size. 

 

Congratulations! You have now managed to visualize the stops of our PLC tag/sensor/etc. Play 
around with the other types of visualizations, using this data, to get a feel of what Power BI can do. 
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Advanced Reports: Combining Two Data Sources 
We will now have a look at how to merge data from two sources together. By now, you should be 
familiar with how to extract data from the devices or lines you are interested in. If not, you can jump 
back to e.g. the section Creating a Stops Pareto from the Stops Data to learn how. 

We start by pulling down the Stops data, from two different devices, on the same day. Once you 
have the two Stops entries in your FIELDS sidebar, we add a single table. From the Stops fields (not 
Stops (2)!) we add the stopCause.stopType, duration and stopCause.name fields. 

 

We now open up the Power BI Query Editor, by clicking Edit Queries, in the toolbar. 

 

You should now get a new window, with the available queries, and their data. 
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We click on Append Queries in the toolbar. 

 

This will open up an Append window, which gives us some options as for what we want to do. 

 

In the Table to append dropdown, we choose Stops (2), and click on the OK button. 

 

We can now see that all our data has been merged into one single table. 
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To make these changes take effect, we click Close & Apply, in the toolbar. 

 

 

Power BI will now apply the updates. 

 

We can then change the visualization of our data from a table, to e.g. a Stacked column chart. 
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Congratulations! You now have an overview of the stops from different production lines, in just one 
graph. 
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Publishing a Report 
Now that we have created our reports, we would like to share them with our colleagues. Power BI 
makes this easy, with the push of a button. Click the Publish button in the toolbar (on the Home tab). 

 

 

You now need to select a destination for your report. You can create several different workspaces, 
for different purposes. In our case, we will simply publish it to the default workspace. Click on Select 
once you have chosen your workspace. 
 

 

Once you have clicked Select, Power BI will begin publishing your report. Once it is done, it will 
present you with two links. The first is directly to your newly published report, and the second is to 
your dashboard. Click on the first link, to go to the report. 

 

This should open a webpage with your report in a browser. It could look something like the picture 
below. 
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You are now ready to share your report with your colleagues! 
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Reset or Change Credentials 
To reset your credentials, navigate to File -> Options and settings -> Data source settings, opening up 
the dialog. 

 

Right-click on the Blackbird Connector entry, and choose Edit Permissions… from the context menu. 
If you just want to reset the credentials, you can instead choose Clear Permissions, and then close 
the dialog. NOTE: If you cannot find the Blackbird Connector in the list, make sure you have selected 
Global Permissions, and that you actually have connected with the Data Connector before. 
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In the Edit Permissions dialog, choose Edit…. 

 

You can now update the credentials for the Blackbird Connector, by entering the new API token in 
the input field, and pressing Save. 

 

You are now ready to run your queries, with your new credentials! 
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Very Quick Tour of the Power BI Connector 
Opening up Power BI, we click on Get Data, which let’s us select the Blackbird Connector. 

 

We can now navigate to the month we want to view. 

 

We continue our navigation to the day we want to view. 



Blackbird Data Connector 
 

page 39 
 

 

Finally, we find the device we are interested in, and select the Stops data. 

 

This adds the Stops data to the FIELDS sidebar, in the right-side of Power BI. 
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We then add a new visualization, Stacked column chart, and drag the stopCause.stopType field onto 
the chart block. After this, we add duration followed by stopCause.name. We should end up with a a 
new column chart, giving us an overview of what types of stops we have, and the breakdown of the 
different stops in these blocks. 

 

That’s it for the quick tour! 
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Resources for Getting Started with Power BI 
The following is a list of resources that might prove helpful, for getting started with using Power BI. 
They are listed in no particular order, and the reader is encouraged to explore each of them and 
decide which might be relevant. 

• Overview of Power BI Desktop and Power BI Service 
https://www.youtube.com/watch?v=1Bo1BrpR3AY  

• Power BI Guided Learning https://docs.microsoft.com/en-us/power-bi/guided-learning/  
• Shaping and combining data https://docs.microsoft.com/en-us/power-bi/desktop-shape-

and-combine-data  

The Power BI Guided Learning resource provides a collection of courses, which the user can pick 
from, depending on their needs. 


